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Microsoft Word 2007 — Introduction to Word Processing 1

How to Start

Word is a full-featured word processing program. Not all Windows computers come with Word. To
see if you have Word, look among your desktop icons, or,

o C(lick Start

o Click All Programs

e C(Click Microsoft Office

e Click Microsoft Office Word

A blank Word document will appear. The blinking cursor, also called the flashing insertion point,
indicates where text you type will appear.

New Document
When you open Word, it opens to a new blank document with a default name of Document1.

Office button

Home tab
fuick Access toolbar Tiile bar More tabs on this row
D“a T Documentl [Compatibility Mode] - Microsofjf - = X
— Home Insert References (7]
X 34 Find -
Ribb AaBbCcD | AaBbCcD AaBb( AaBbCi % &_Repiace
| on T Mormal | Mo Spaci.. Headingl Heading2 - g?yalgsgve s Select -
Clipboard Styles (F] Editing
] BN RN Y SRR AR

Ruler bar

Font Group Paragraph Group

Each Tab in the tab row has its own Ribbon. This is the ribbon for the Home tab. Each ribbon is
divided into groups. We will use the Font and Paragraph groups in this class.

Basic Typing
Watch the blinking cursor. Iltis ﬁg) FEEDL Document2 {Compatbilty Model - Microsoft Word - o
- TN .
positioned where the top and left B A e x (519 [sopocen] nesbceo aaBbC dabe A4 P77
. Pate o [B 2 U - A A - (& Phormst | THoSpaci.  Heading1 | Hesding2 - Change :mm
margins meet. - . o e

As you type, when you get to the end
of the line, Word will automatically
wrap to the next line.

If you want to go to the next line
before you get to the end, press the
Enter key on the keyboard.

Use the Backspace or the Delete keys
to erase. Backspace erases to the left :
of the cursor. Delete erases to the :

E———

rlght ooy oo S [EEEEE T
Keep watching the blinking cursor!
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Try this:
Type a single word. Do not capitalize it. After you type the word, press the space bar. Notice that
Word capitalized it for you! This feature is called AutoCorrect. Type a word incorrectly and,

sometimes, Word will correct for you. Try this: type recieve. As soon as you press the space bar,
watch it change to the proper spelling of receive!

Try this:

On the Home ribbon, find the Font Group. In the Font Group, find the box with the word Calibri.
That is the font style box. There are many fonts. Click on the down arrow on the right side of the
font style box to see the choices. Choose Arial Black. Type another word to see what that font looks
like. Now click on the font size box—it may have an 11 or 12 in it now. Click on the down arrow to
the right of the number and click on 48. Type another word. See the difference! Change the font
back to size 14. Type another word. Notice that when you made a change such as font style or font
size, it did not change what you typed previously. It’s not supposed to. When you make a change, it
will be from the cursor forward and will not change anything you typed previously.

Try this:
On the Home ribbon, find the Paragraph Group.
Dvu \ = o Documentl [Compatibility Mode] - Microsoft Word - 8 x
_;_j/‘ Home Insert Page Layout References Mailings Review View Developer (7]
- = |l - = (e . 44 Find -
Calibr Bod) e & w2 Sl F8(T] [aansce| aasbce AaBbC aBbC . A Replace

) B 7 U -ahe x, x Aa||¥ - A || Sy TMormal | T Mo Spaci.. Headingl Heading2 - Change

Styles~ || kg Select~

Clipboard = Font = Styles (F Editing

=
|
-
N
|5l

= Align Left—align on the left margin. It is on by default
= Align Center—this will center text between the left and right margins
= Align Right—this will align text on the right margin

= Justify—will provide a flat right margin

Moving Around: Know where your cursor is!
e Arrow keys — Move the cursor up, down, left, or right only where there is text.
e Home key -- Moves the cursor to the beginning of the current line
e Ctrl Home — Moves the cursor to the beginning of your document
¢ End key -- Moves the cursor to the end of the current line
e Ctrl End — Moves the cursor to the end of your document
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e Mouse -- Click the mouse once in the text and the cursor will be located where you click.

I Word 2007 and single spacing Ruler Bar — Display the Ruler Bar

Word 2007, by default, is set for 1.15 line spacing. From the View tab,
Why Microsoft did that, we'll never know but this e Checkmark Ruler
is how you change it.

Baferences Mailings Review View Develaper A
From the Home tab @ Document Map I% """ JOne Page
! ridlines Thumbnails | & = |JTwo Pages

e Click on Change Styles (right side of ribbon) o =
e Click on Style Set

e Click on Office 2003
e Click on Change Styles, again
e Click on Set as Default

Change margins
Click on the Page Layout tab. Then click on Margins

N B AN DA Documentl - Microsoft Ward - =7 X
| ’3
Home rt References Mailings Review Wiew Add-Ins IQ)
. __n, rientation ~ ',Z: 4] Watermark ~ | Indent Spacing 4 Bring to Front =k
£~ | M Page Color~ | =0 - :: 0 pt - 44 Send to Back - ]
Themes Margins __ g = Paosition
.g FColumns - pl~~ || [0 Page Borders Al . I; 0 pt : M| Text Wrapping ~ S
Themes Page Setup i || Page Background Paragraph IF] Arrange
[ e P4 3 3 a4 1B 4R a7 oao& A =
CNC AL Ve RR
—j H ns Page Layout References
- =y Oricgtation ~ k= Breaks =
Aa Al J 5 size $2 Line Numbers = Note: Generally, we do not recommend that you
N T e s ™ b Eyphenaniont® change the margins using the Ruler Bar. Even
TNEMES #;;l Costomsetting expert Word users can make a mess trying to do
! lefi 04" Righti 04" it that way.
Mormal
Taop: 1" Bottom: 1"
. g left; 17 Right: 1"
- Marrow
B Top: 0.5" Bottom: 0.5
: g left; 05" Right:  0.5"
: Moderat . .
: Eﬂ Tomr & Bottom: 1 Click on Custom Margins to change the
- left: 075" Right 0.75" . .
: default margin settings or to choose
o Wide . . .
: E Tp 1 Botion: 1 different settings than the ones listed.
- eft: ight:
) Mirrored
- Top: 17 Bottom: 1" i i
B mﬂ Ir?s?de: 1.258" Ooutsoigne:l" CIICk on the bUtton In the

: S — " lower left corner of the next screen to
1 S 5 change the margins for all future
: ( Custom targine. documents. Then click on OK.
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Font: Change the default font

@ — '\._: = O

Ta Documentl [Compatibility Mode] - Microsoft Word - 7 X
fy Home Insert Page Layout References Mailings Review View Developer '!J)
- + |l == | ([ 1 33 Find -
Calibri (Body) 12 ~||A A ||—_/| [E=mzs=rm=| [ ==||%H| q’[| AaBbCeD | AaBbccD AaBb( AaBbC = % & Repince
Paste f 'B I Wl | TMormal | T Mo Spaci.. Headingl Heading2 — g?yalgsg'e s select -
Clipboard & {F] Styles (F] Editing
e e —————— e R
||
Click on the down arrow to the right of the Font group name.
Font EJE|
Choose the font you want. The default font Fort  EERERED
is Calibri. Two other commonly used fonts e T
are Times New Roman and Ariel. BB Regular 2
I s =
+Headings Italic 9
e s |2
H H i old Italic
Choose the size font. The default is 11. Most Algerian 2 -
peOple prefer 12 Font colar: Underline style:
Automatic | | {none) w
Effects
To make these changes apply to all future [ strkethroogh [ shado [ sl caps
H H [ Double strikethrough [ outline [ all caps
documents, click on and then click o Do Dl
on OK. [ Subscript [ Engrave
Preview
+Body
This is the body theme font, The current document theme defines which Font will be used.,
5] oo

Add text: Position the cursor at the place where you want to insert text and start typing. Move
your cursor to the next place where you want to change text.

Delete text: Position the cursor at the place where you want to delete text. There are several ways
to delete text:

e The Delete key erases the character to the right of the cursor.
o The Backspace key erases the character to the left of the cursor.
e Select the text and press the Delete key to erase a large amount of text.

Tabs: Press the Tab key on the keyboard to move the cursor % inch. To set a tab, just click on the

ruler bar. To remove a tab stop, put your mouse on the tab marker in the ruler bar. Drag the tab
stop down into the document.
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SAVE: The first time you save a document, click on the Office Button. Click on Save As and you will
see the Save As dialog box.

Save As E]@
. . . Save in: D My Documents ~ @ -0 X ChiE-
Flnd the Flle name bOX' NOtlce E'Trusted Marne Size | Type Date Modified ~
. . Templates par— .
that there W|” be some typlng iy Recent ﬂbhlnt.nns Dotuments File Folder 9{21/2010 11:51 AM
‘-bDocuments I__)Big Picture File Folder 10/26/2008 6:00 AM
1 1 1 1 ILCIBP File Folder 2(29/2009 1:41 PM
In the box that IS hlghllghted @Desktup I)Competency 2001 File Folder 10f26f2008 6100 AM
H 1 I1Downloads File Folder S/16/2010 3:09 PM
b I u e * W h e n So m et h I n g I S EI glgcuments ICIEmail Archives File Folder 10/26/2008 6:00 AM
H H ' [CIEMS Fils Folder 7/19/2010 3111 PM
I
hlghllghted bluel It IS ready for J cgmputer |_)Favorites File Folder 10/26/2008 6:00 AM
H H | My Hetwork. |C)Fines & Fees File Folder &(25/2009 2124 PM
yo u to type . G ive you r fl Ie a "J Flaces |C)Learning Styles 2006 File Folder 51192009 1:46 PM
H jMy Music File Folder 7i1f2010 5142 AM
name that reﬂeCtS lts Content :',My Pictures File Folder 10/2010 12144 PM
H H IL_)My Practice Files File Folder Tizzlz0l0 4121 PM
SO that When you see lt Ina ||Stl EMyVideDs File Folder 192010 &:22 AM
. s [CINED Fils Folder 10/26/2008 £:00 AM
yo uwi I | kn ow Wh at It IS. ILoutlonk, File Folder 10f26{2008 6100 AM
|_)Position Description File Folder 10f1/201012:16 PM
ILZ)5kaff training File Folder 10/1/2010 12:09 PM ~
File name: Doct doc v
Save ssEYPE! | ward 97-2003 Document (*.dac) v

Hint: Click on the “diskette” button on the Quick Access toolbar to do quick saves every 5-10
minutes after you save your file the first time. If a power outage or other problem causes your
computer to freeze, you’ll only lose 5-10 minutes of work not hours.

Reminder: Use Print Preview before you print to see what your document will look like when it
prints. Make any changes to margins, spacing etc. before printing. You’ll save paper, ink and time.
Find Print Preview by clicking on the Office button in the upper left corner. Point at Print. Click on
Print Preview. Or, you can add it to the Quick Access toolbar.

Edit Text: Add or delete text. Cut, copy or paste text. Change the font, font size, font color. You
can change just about anything if you select the text! Selecting text is the key to successful editing.
Selecting text is so important, we put the instructions in a box!

Ways to Select (Highlight) Text
Mouse -- Hold the left button down as you drag the mouse across the words you want to select.
Double-click in a word to select that word.
Triple-click in a paragraph to select the current paragraph
Click in the left margin to select the current line.
Double-click in the left margin to select the current paragraph.
Triple-click in the left margin to select the entire document.

[Shift] + arrow keys -- Position cursor at start or end of text. Hold down the [Shift] key while you
use the arrow keys to select the text.

[Ctrl] + Mouse - Hold down [Ctrl] and click in a sentence to select that sentence.

[Ctrl] + A -- Hold down the [Ctrl] key while you press [A] to select the entire document.

Note: To deselect text, click outside the highlighted text or press an arrow key.
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Copy and Paste After you select the text that you wish to copy by using one of the methods listed

above, click on Copy. Click where you want the copy to go—the blinking cursor will be in the spot.
You can copy to the same document or another document or program. Click on Paste.

Cut Text - For any text you want to move to another place in a document. Select the text. Click Cut
&< and click where you want to reposition the text. Click Paste. This works the same as copy except
the text is gone from the first position.

Some Keyboard Shortcuts in Word

Ctrl+ N
Ctrl+ O
Ctrl+S
Ctrl+P
Ctrl + A
Ctrl + X
Ctrl+C
Ctrl+V
Ctrl+2Z
Ctrl+Y

New file

Open file

Save file

Print file

Select all

Cut selection to the clipboard
Copy selection to the clipboard
Paste selection from the clipboard
Undo

Redo

The following keyboard shortcuts work like "on/off" switches. Press to start that formatting
command and press again to stop that formatting command.

Ctrl +B
Ctrl + 1
Ctrl+ U

Bold
Italic
Underline
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